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1Touchpad MODULAR Ver. 2.1-VIII (Answer Key)

	   Computer Networking

Exercise

A.	 1. a 	 2. b 	 3. c 	 4. a

B.	 1. F 	 2. T 	 3. T 	 4. T 	 5. T

C.	 1. Protocol 	 2. SMTP 	 3. Router 	 4. Mesh 	 5. NIC

D.	 1. �The process of connecting computers and peripheral devices with each other, so that they 
can exchange data and resources is called computer networking.

	 2.	A client is a computer which depends on the server for specific resources. 
		  A server controls the access to the hardware and software on the network. 
	 3. Topology refers to the physical or logical arrangement of computers or nodes in a network. 
	 4. Network Interface Card (NIC), Hub or Switch, Router, Modem and Networking Cable.
E.	 1. �The advantages of computer network are:
	 	 (i)	 The information can be easily shared by the people.
	 	 (ii)	 It helps in reducing the cost of hardware.
	 	 (iii)	Store information on one centralised location.
	 2. �LAN is a digital communication system that interconnects a larger number of computers and 

other peripheral devices within a radius of less than 1 km. MAN consists of two or more local 
area networks or campus area networks together that usually spans several buildings in the 
same city or town.

	 3.	�Protocol is a set of rules that governs the communication between the computers on a network. 
Different types of protocols used for different operations on the Internet are Hypertext Transfer 
Protocol (HTTP), Hypertext Transfer Protocol Secure (HTTPS), File Transfer Protocol (FTP) etc.

F.	 1.	Rahul should select the Ring Topology.
	 2.	Aarav should implement a Web Server.

In the lab

Do it yourself.

1.
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	   Photo Editor and Video Editor

Exercise

A.	 1. c 	 2. a 	 3. b 	 4. d 	 5. c
B.	 1. T 	 2. T 	 3. F 	 4. T
C. 	 1. Three components of OpenShot Video Editor are Menu Bar, Main Toolbar and Function Tabs.
	 2. �Video editing is the process of adding or removing content from an existing video and 

applying effects to it.
	 3. �Yes, we can add transition effects in a video using the Transitions button in OpenShot Video 

Editor.
D.	 1. �Rotating means to change the position of a photo at different angles. Flipping means to get 

the mirror image of the photo either horizontally or vertically.
	 2.	The steps to import a media file in OpenShot Video Editor are:
	 	 Step 1  Click on the File menu. A drop-down menu appears. 
	 	 Step 2  Select the Import Files option. The Import Files dialog box opens. 
	 	 Step 3  Navigate to the location where the media file is saved. 
	 	 Step 4  Select the desired video. 
	 	 Step 5  Click on the Open button. 
	 3.	�Adjustments feature is used to adjust the brightness and contrast of a photo in Photo app. 

Follow the steps given below to use the Adjustments feature: 
	 	 Step 1   Open a photo in editing mode. 
	 	 Step 2 � Click on the Adjustments tab. The Adjustments pane with various adjustment options 

appear at the right-hand side in the Photos app window. 
	 	 Step 3  Adjust the brightness of the photo by moving the options in the Light Slide. 
	 	 Step 4  Adjust the colours of the photo by moving the options in the Color slide. 
	 	 Step 5  Click on the Save options button to save the changes made. 
E.	 �Rahul can use the Crop option in the Photos app to remove unwanted portions from the corners 

of his photo.

In the lab

Do it yourself.

2.
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Worksheet 1
(Based on chapters 1 & 2)

A.	 1. Local Area Network 	 2. Personal Area network 
	 3. Star Topology 		  4. Mesh Topology
B.	 1. File 
	 2. Import Files, Import Files 
	 3. location
	 4. video
	 5. Open 
C.	 1. Rotating 	 2. Flipping 	 3. Protocol 	 4. Wi–Fi

	   Introduction to GIMP 

Exercise

A.	 1. b 	 2. c 	 3. a 	 4. a 
B. 	 1. Workspace	 2. GIMP 	 3. Layer effect 	 4. Layers palette 
	 5. Patterns 	 6. Fill with
C.	 1. GIMP has user friendly interface.
	 2. Template represents image types that are commonly useful.
	 3. Menu bar, Toolbox and Layers palette.
D.	 1. To save a file, follow the given steps:
	 	 Step 1	 Click on File menu.
	 	 Step 2	 Click on Save option.
	 	 Step 3	 Navigate the folder to save the file.
	 	 Step 4	 Given the name of the file in the Name: box.
	 	 Step 5	 Click on Save button.
	 2. To open an image, follow the given steps:
	 	 Step 1	 Click on the File menu.
	 	 Step 2	 Click on the Open option.
	 	 Step 3	 Choose the image to be inserted.
	 	 Step 4	 Click on the Open button.

3.
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	 3. The Create a New Image dialog box provides the following options:
	 	 ∑ � Template: It represents image types that are commonly useful. The template sets values 

for  the size, resolution, comments, etc.
	 	 ∑ � Image Size: It specifies the width and height of the new document in pixels, centimeters, 

inches, points, millimetres, etc.
E.	 �Nitin should use GIMP because it is a free and open-source graphics editor with powerful 

features. It supports many file formats, allows advanced image editing, and is lightweight. 
Unlike expensive software, GIMP offers professional-level tools without any cost, making it a 
great choice for students and graphic designers alike.

In the lab

Do it yourself.

	   Using Tools in GIMP

Exercise

A.	 1. c 	 2. b 	 3. c 	 4. a
B.	 1. F 	 2. T 	 3. T 	 4. F
C.	 1. Rectangle Select 	 2. Text	 3. Sharpen	 4. Clone
D.	 1. �Fuzzy Select tool is used to detect the edges of the image automatically on the basis of colour 

codes and do the selection quickly. 
	 2. Retouching tools help you to add or remove objects from an image.
	 3. �Smudge tool is used to show the image as the wet paint on the image has been spread by 

a finger.
	 4.	�Correction tools are used to improve the quality of the image by blurring, sharpening, 

smudging, dodging and burning the image. 
E.	 1. �Paintbrush tool is used to draw brush strokes to give an effect of painting to the image. The 

Paintbrush tool shows various options. For example, Opacity option is used to increase or 
decrease the transparency of the brush color. To use the Paintbrush tool, follow the given 
steps: 

	 	 Step 1	 Choose a colour for your Paintbrush by adjusting the gradient sliders.
	 	 Step 2	 Choose the type of Brush from the Brushes tab.
	 	 Step 3	 Click on the workspace and drag to draw the flow of brush.
	 2. To use Clone Tool, follow the given steps:
	 	 Step 1	 Open the image and then click on Clone Tool icon in the Toolbox..
	 	 Step 2	 Select the brush size and hardness from Tool Options.

4.
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	 	 Step 3	 Press and hold the Ctrl key and click on the image to be cloned.
	 	 Step 4	 Click and drag the mouse at the place where the clone is to be created.
	 3. To use Blur tool, follow the given steps:
	 	 Step 1	 Open an image.
	 	 Step 2	 Click Blur/Sharpen Tool icon in the Toolbox. 
	 	 Step 3	 Select the brush size and hardness.
	 	 Step 4	 Click and drag the mouse pointer over the area that you want to blur.
	 4.	�Healing tool is used to repair dark spots, scratches, etc. from the image. To use Healing Tool, 

follow the given steps: 
	 	 Step 1	 Open the image you want to retouch. 
	 	 Step 2	 Click on the Healing Tool icon in the Toolbox. 
	 	 Step 3	 Choose the brush size. 
	 	 Step 4	� Press and hold Ctrl key. Click on the spotted area to remove the spots and then 

release Ctrl key.
F.	 �Nazia should use the Fuzzy Select Tool to automatically select the edges of the image based 

on colour. Then, she should use the Crop Tool to keep only the selected portion of the image.
In the lab

Do it yourself.
 

	   Advanced Features of GIMP

Exercise

A.	 1. a 	 2. b 	 3. b 	 4. c
B. 	 1. F 	 2. F 	 3. F 	 4. T
C. 	 1. Eye 	 2. tab 	 3. copying, pasting 	 4. Filters
D.	 1. �Layers allow you to work on individual objects in an image separately without affecting the 

others.
	 2. �Layers are transparent sheets which are stacked on top of each other so that individual objects 

of an image can be edited without affecting other objects.
	 3. Filters are tools which are used to modify an image in a variety of ways.
	 4. �Hiding a layer means to make the layer temporarily invisible. When a layer is hidden, its 

content is also hidden from the view.
	 5.	�Merging layers is needed when you want to combine multiple layers into one for simplification 

or final image saving.

5.
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E. 	 1. �Flattening layers in GIMP merges all visible layers into a single layer, effectively combining 
all elements of the image into one. To flatten layers, follow the given steps:

	 	 Step 1	 Select a layer which you want to flatten.
	 	 Step 2	 Right click on the Layers palette and select Flatten Image.
	 2. To delete a layer, follow the given steps:
	 	 Step 1	 Select a layer from the Layers palette.
	 	 Step 2	 Click on the Delete this layer button.
	 3. To apply filter to an image, follow the given steps:
	 	 Step 1	 Open an image in GIMP.
	 	 Step 2	 Select the part of the image where you want to apply the filter.
	 	 Step 3	 Click on the Filters menu from the menu bar.
	 	 Step 4	 Choose Blur filter from this submenu.
	 	 Step 5	 Click on Gaussian Blur option.
	 	 Step 6	 Increase the value of the X and Y size to decrease or increase the effect of the filter.
	 	 Step 7	 �After you have applied the suitable value to the filter, click on OK button to apply 

the effect.
F. 	 1.	�The most suitable feature for creating a photo collage in GIMP is the Layers feature. Layers 

allow Ankita to insert multiple images in a single file, arrange them creatively, and adjust 
their size, position, and blending without affecting the original images. This makes it ideal 
for designing collages.

	 2.	For this, Shaurya can do this tasks by merging two images process in GIMP. 
In the lab

Do it yourself.
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Worksheet 2
(Based on chapters 3 to 5)

A.	

Layer stack

Delete this layer

Creater a 
duplicate layer

Creater a new 
layer group

Creater a new layer

Raise this layer

Eye icon

Lock button

Layer tab

Merge this layer
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C. 	 1. Healing Tool	 2. Clone Tool
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Test Sheet 1
(Based on chapters 1 to 5)

Section A

A.	 1.	a	 2. c 	 3. d 	 4. c 	 5. c 
	 6. d 	 7. b 	 8. a	 9. b	 10. c
B. 	 1. F 	 2. T	 3. T	 4. F	 5. T
	 6. F	 7. T	 8. F 
C. 	 1. SMTP 	 2. Mesh 	 3. Workspace 	 4. Layers palette 
	 5. Rectangle Select		 6. Sharpen	 7. tab 	 8. copying, pasting

Section B

A.	 1. �The process of connecting computers and peripheral devices with each other, so that they 
can exchange data and resources is called computer networking.

	 2. �Video editing is the process of adding or removing content from an existing video and 
applying effects to it.

	 3. Template represents image types that are commonly useful. 
	 4. Retouching tools help you to add or remove objects from an image. 
	 5. �Hiding a layer means to make the layer temporarily invisible.  When a layer is hidden, its 

content is also hidden from the view.
B. 	 1. The advantages of computer network are: 
	 	 •  The information can be easily shared by the people. 
	 	 •  It helps in reducing the cost of hardware. 
	 	 •  It store information on one centralised location. 
	 	 • � Reliability implies backing up of information. If a system crashes, then the information is 

accessible on another workstation for future use. 
	 	 •  Reduction in installation cost. 
	 	 •  User authentication process to secure the data. 
	 2.	The steps to import a media file in OpenShot Video Editor are as follows:
	 	 Step 1	 Click on the File menu. A drop-down menu appears. 
	 	 Step 2	 Select the Import Files option. The Import Files dialog box opens. 
	 	 Step 3	 Navigate to the location where the media file is saved. 
	 	 Step 4	 Select the desired video. 
	 	 Step 5	 Click on the Open button. 
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	 3.	The Create a New Image dialog box provides the following options: 
	 	 • � Template: It represents image types that are commonly useful. The template sets values 

for the size, resolution, comments, etc. 
	 	 • � Image Size: It specifies the width and height of the new document in pixels, centimeters, 

inches, points, millimetres, etc. 
	 4.	To use Blur tool, follow the given steps: 
	 	 Step 1	 Open an image. 
	 	 Step 2	 Click Blur/Sharpen Tool.
	 	 Step 3	 Select the brush size and hardness. 
	 	 Step 4	 Click and drag the mouse pointer over the area that you want to blur. 
	 5. �Flattening layers in GIMP merges all visible layers into a single layer, effectively combining 

all elements of the image into one.  To flatten layers, follow the given steps: 
	 	 Step 1	 Select a layer which you want to flatten. 
	 	 Step 2	 Right click on the Layers palette and select Flatten Image.

	   Introduction to TUPI 2D

Exercise

A.	 1. a 	 2. a 	 3. b 	 4. a 	 5. d
B. 	 1. F 	 2. T 	 3. F 	 4. T 	 5. T
C. 	 1. Animation is a way through which you can show characters and objects live.
	 2. �Ink tool is used for creating and outlining artwork with various brush styles, giving a more 

refined and stylised look to your drawings.
	 3. Menu Bar, Modules Tab and Workspace
D. 	 1. To start TUPI 2D, follow these steps: 
	 	 Step 1	 Type TupiTube in the search box.
	 	 Step 2	 Click on TupiTube Desk app.
	 2.	�Object Selection tool is used to select the objects which are created in different layers or 

frames whereas Node Selection tool helps to reorder the nodes which were created while 
drawing an object.

E.	 The Paint Bucket Tool can be used to fill different colours in the objects Sahil has drawn. 
In the lab

Do it yourself.

6.
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	   Animations in TUPI 2D

Exercise

A.	 1. c 	 2. a 	 3. b 	 4. c
B. 	 1. F 	 2. F 	 3. F 	 4. T
C. 	 1. Tween helps us to make animation process easier and faster.
	 2. �Layers are like stack of transparent sheets that are used to work on the individual part of the 

image without affecting the other parts.
	 3. �Color tweening allows for the gradual change in colour of an object between keyframes, 

creating a smooth colour transition.
D. 	 1. We can insert the frames in TUPI by following the given steps:
	 	 Step 1	 Click on the Exposure Sheet in the right sidebar.
	 	 Step 2	 Click on Insert Frame button.
	 2. To use Motion tween, follow the given steps: 
		  Step 1	 Draw any object on the workspace area. 
		  Step 2	 Click on Tween option from the Toolbox. 
		  Step 3	 Choose Motion Tween option. 
		  Step 4	 Type a name for the tween and click on + button. 
		  Step 5 	 Select the object by using the Object Selection tool. 
		  Step 6	 Click on Set Path Properties radio button. 
		  Step 7	� Click at different points to set the path for the animation. As you click, Tupi will 

automatically create path for you. 
		  Step 8	 Click on Save Tween button to save the animation. 
		  Step 9	 Click on Player tab to play the animation in the player window.
	 3. �Rotation Tween is useful to rotate an object clockwise and anti-clock wise because the Rotation 

tween automatically rotates the object as per the specification given.
E. 	 �To rename a layer in Tupi 2D, Shweta should double-click the layer in the Layers panel, type a 

new name, and press Enter to confirm the change.
In the lab

Do it yourself.

7.
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Worksheet 3
(Based on chapters 6 & 7)

A.	 Paint Area Actions ToolbarWorkspaceMenu Bar

Toolbar

Left Side 
bar

Toolbox

Right Side 
bar

Exposure 
sheet

Expanded Panel

B.	 1. �Motion tween helps move an object. The Motion tween automatically creates intermediate  
frames for you. 

	 2. A frame is a single animation that is applied on an object or picture on a timeline. 
	 3. Shear tween changes the object’s horizontal and vertical shear. 
	 4. �PolyLine tool is a drawing tool that allows users to create lines composed of multiple straight 

segments.
C. 	 1. Welcome screen 
	 2. Expanded Panel 
	 3. Color Palette
	 4. Opacity Tween

	   App Development

Exercise

A.	 1. a 	 2. a 	 3. a 	 4. b
B. 	 1. F 	 2. T 	 3. F 	 4. T 	 5. T
C. 	 1. Hybrid 	 2. Mobile 	 3. Android 	 4. Gaming	 5. Install 

8.
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D. 	 1. �An app is a software program primarily developed for hand-held smart devices such as mobile 
and tablet.

	 2. �A Web app is an application program that is stored on a remote server and accessed over 
the Internet through a Web browser interface.

	 3. Built-in Blocks, Component Blocks and Workspace
E. 	 1. 	  (i) �Entertainment apps are developed to entertain people. These apps allow users to watch 

videos, post photos, search upcoming events, etc. The most commonly used entertainment 
apps are Netflix, Disney+ Hotstar and YouTube. 

	 	  (ii) �Utility apps allow us to do our daily tasks such as booking a cab, booking a railway ticket, 
booking an appointment with doctor, sharing files, and performing calculations. The most 
commonly used utility apps are InShare, Calculator, and Flashlight. 

	 	 (iii) �Communication apps allow us to communicate with each other by sending and receiving 
messages, information, and opinions in the form of texts, videos, and audios. The most 
commonly used communication apps Skype, Signal, and FaceTime.

	 2. To change the display name of button, follow the given steps: 
	 	 Step 1	� Click on the button in the Viewer pane or click on the button name in Component 

pane. 
	 	 Step 2	� Select the Text option in Properties pane and change ‘Text for Button1’ to the text 

you want to display on the button.
	 3.	�The difference between web app and website is that a web app can be a small part of a 

website which provides a particular functionality. On the other hand, a website can contain 
many web apps.

	 4. �Educational apps provide a platform for children to learn from anywhere and anytime. These 
apps use advanced methodologies and new concepts to make the learning easier. The most 
commonly used educational apps are Khan Academy, Vedantu, and English Grammar.

F. 	 1. Candy Crush is a Gaming app.
	 2. Suraj can use Music apps like Spotify, Apple Music, or YouTube.

In the lab

Do it yourself.

	   Loops in Python

Exercise

A.	 1. a 	 2. a 	 3. a 	 4. c
B. 	 1. one 	 2. non-zero, false 	3. Infinite 	 4. break, continue

9.
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C. 	 1. T 	 2. F 	 3. T 	 4. T 
D. 	 1. �Looping refers to the process of repeating a set of statements repeatedly on the basis of a  

condition until the condition is falsified. 
	 2. The syntax of for loop is
	  	for <counter variable> in range(start, stop, step_size): 

	 	     statements

	 3. �Jumping statements are used in Python when the control of the program needs to be 
transferred out of the loop body, even if all the values of the iterations of the loop have not 
been completed.

E. 	 1.	�If the condition given in a loop never becomes false, then the loop will never terminate and 
run indefinitely. This type of loops is called an infinite loop. 

	 	 Example: 
	 	 while(1) 

	 	 print(“Hello”) 

	 	 Output: Hello will be printed infinite times. 
	 	� To come out of the infinite loop, we can either close the program window or press Ctrl + C. 

This will break the running of the program. 
	 2.	�The while statement executes a set of statements repeatedly, until the logical expression 

evaluates to true. When the condition becomes false, the control comes out of the loop. The 
syntax of while statement is given below: 

	 	 while (test expression): 
		      Statements 

		      Increment/Decrement 

	 	 The following example shows the use of a while loop. 
	 	  # Initialize a variable 

	 	 count = 1 

	 	 #test expression 

	 	 while count < 5: 

	 	     print(“Count is:”, count) 

	 	     count += 1

	 3.	�The break statement halts the execution of a loop and program flow switches to the statement 
after the loop. A single break statement will break out of only one loop. On the other hand, 
the continue statement is used inside loops. When a continue statement is encountered 
inside a loop, control of the program jumps to the beginning of the loop for next iteration, 
skipping the execution of rest of the statements of the loop for the current iteration.
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F.	 1.	55
	 2.	2

In the lab

Do it yourself.

Worksheet 4
(Based on chapters 8 & 9)

A.	 1. Google Play Store 	 2. iOS 	 3. Hybrid app 	 4. Gaming app 
	 5. Educational app 	 6. Social Networking apps
B.	 1. i = 0
		  while i < 5:

		      print(i)

		      i += 1

		      if i == 3:

		          break

		  else:

		      print(0)

	 2. i = 0
	 	 while i < 3:

	 	     print (i)

	 	     i += 1

	 	 else:

	 	     print (0)

C. 	 for num in range(39, 0, -2):

	     print(num)

Test Sheet 2
(Based on chapters 5 to 8)

Section A

A.	 1. b.	 2. a.	 3. c.	 4. b.	 5. a.
	 6. b.	 7. a.	 8. a.
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B. 	 1. T 	 2. T 	 3. F 	 4. F 	 5. T 
	 6. T 	 7. F 	 8. T 
C. 	 1. install	 2. Mobile	 3. Android	 4. gaming	 5. one
	 6. break, continue 

Section B

A.	 1. Animation is a way through which you can show characters and objects live.
	 2. �Color tweening allows for the gradual change in colour of an object between keyframes, 

creating a smooth colour transition. 
	 3. �A Web app is an application program that is stored on a remote server and accessed over 

the Internet through a Web browser interface. 
	 4. The syntax of for loop is 
	 	 for <counter variable> in range(start, stop, step_size): 

	 statements
B. 	 1. �Object Selection tool his used to select the objects which are created in different layers or 

frames whereas Node Selection tool helps to reorder the nodes which were created while 
drawing an object.

	 2. We can insert the frames in TUPI by following the given steps: 
	 	 Step 1	 Click on the Exposure Sheet in the right sidebar. 
	 	 Step 2	 Click on Insert Frame button.
	 3. �The difference between web app and website is that a web app can be a small part of a 

website which provides a particular functionality. On the other hand, a website can contain 
many web apps. 

	 4.	�The while statement executes a set of statements repeatedly, until the logical expression 
evaluates to true. When the condition becomes false, the control comes out of the loop. The 
syntax of while statement is given below: 

	 	 while (test expression): 

	 	     Statements 

	 	     Increment/Decrement 

	 	 The following example shows the use of a while loop. 
	 	  # Initialize a variable 

	 	 count = 1 

	 	 #test expression 

	 	 while count < 5: 

	 	     print(“Count is:”, count) 

	 	     count += 1


